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New Documents or Templates
**Not a new page

1. Click File on the menu bar, then select New

2. Make your selection — memos, other documents (agenda), letters & faxes, reports, publications
(brochure, manual, directory), web pages T T
3. Memos: choose the type of memo you desire — [ 1
4. Click Template on the right side of the box - w Mem p,na‘
5. Follow instructions . e
6. Highlight the body of the memo and press Delete oammi
on the keyboard
7. Type the memo

Envel opes Exsreiopss aad Libats
1. Tools, Envelopes and Labels, click on Envelopes Tab i":‘!:‘" — -
2. Type name and address in the Delivery Address text box B 7 oo |
3. ** Click on the Address Book button to open the address book ﬁ}
4. Click Omit to avoid printing a return address, if desired E
5. Click Options to change envelope size, font type and size, or ”'“'"’““—:IM hreven rosd
position of address El o
6. Click Print to send the envelope to the printer or Add to Document 5 T
to add a page containing the envelope to the current document.
Labels — "
1. Tools, Envelopes and Labels, click on Labels Tab s @1 oeomen |
2. Click Options to change label size 8 e
3. Click Label products drop-down button to select type of label , OK - —mn |
4. For a single label — type in desired information and select single label or 7~ e
Full page of the same label im%‘““m S
5. For several different labels — select New Document e
6. In New Document — type desired labels, adjust borders as desired
Drop Cap K E3
Drop Cap P’tf ’T, ’T,
1. Point to and click the paragraph to begin with a drop cap E
2. Click Format, Drop Cap Wone. Dropped  InMargn
3. Click desired Position of drop cap Options
4. Click the Font drop-down button to change the font Font:
5. Click Lines to Drop text box to change the size of the letter OK fimes e Renen -
Lines ko drop: m
Diskance from kexk: m
,TI Cancel I
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Format Painter

1. Click and drag to select the text with the formatting you would like to copy
2. Click once on the Format Painter Button _

3. Click and Drag over text to format |

To Paint the same Format more than once:

4. Click and drag to select the text with the formatting you would like to copy
5. Double-Click the Format Painter Button

6. Click and Drag over each text section to format

7. Click the Format Painter button to turn painting off

Date and Time [ 2] %]

Date and Time Available formats:
1. Click Insert, Date and Time
2. In the Available Formats list box, click desired format

10j12/99 10:01 AM
10/15/99 10:01:42 AM Jhd|

I Update automaticalky

** To have the date or time update automatically each time the document is opened, click the Update
Automatically checkbox

Find and Replace Text
1. Click Edit, Find
2. Select Find or Replace

Text Boxes

Create a Text Box

Click Insert, Text box

Click and drag to draw a text box of a desired size
Type desired text

Format text as desired

When finished, click within the body text

Nk e

Format a Text Box

1. Select text box

2. Click Format or right click the text box

3. Click Format Text Box

4. You can change margins in the Text Box tab

5. You can change borders in the Colors and Lines tab
6. Click Wrapping tab to change wrapping styles
Prepared by MLY 3
Technology Dept.

2002-2003



Link Text Boxes

Linked Text boxes allow you to flow text from one box to the next. If text is edited or box size is changed,

text automatically flows between boxes to fill the space.
Click the first text box to select it

Click the next text box (the pitcher pours)
Repeat steps 2-4 for each link

B —

Break Links Between Text Boxes
1. Click first box containing link to break
2. Click the Break Forward Link bottom

Columns

1. Click on Format

2. Click on Columns

3. Select 2 Columns

4. Click Line between box

5. Click on down arrow beside Apply to: and select

From this point forward
6. Click OK

Column Break

1. Click on Insert

2. Click on Break

3. Click on circle in front of Column Break
4. Click OK

Hyperlink

On the text box toolbar, click the Create Text Box Link button

Columns

— P& o

el

reset:

(]

e

— i
o
=T
1=
&
T

Twn  Three

|

Cancel |

Line between *

Mumber of columns: v
idth and spacing revies
Col #: Width: Spacing:
[ Jarr Hos
= =3 =
| | = =
column width —

v Equal

Apply ko:

‘whole document n
This paint forvard

1. Highlight the word or phrase in the question that you want to be the link

&

Link

2. Click the Link icon on the toolbar
3

Type the website address in the Link to page location... box

Or

- Link ko

I™ Start new column

Link to a page location or local file:

LChoose File |

| hktp: £ e whitehouz e, gon

4. If you copied the address straight from the web page and you want to paste it into the link —
where it says Link to page location..., right-click & select Paste

5. Click Apply
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Table of Contents

In the document on which the table of contents is to be based -
Click Insert, Index and Tables
Click Table of Contents tab

Index and Tables HE

| Table of Conkents | Table of Figures | Table of Authorities |

Nk W=

Click desired style e
. Type TEvie
Choose number of levels in the Show Levels text # Indented ‘Aristotls, 2 ﬂ Lo |
box " Rupin Asteroid belt. See Tupiter Cancel |
6. Click Tab leader list box to choose a leader Formats: A“E;’jihm Mok iy |
Style, OK Classic = exosphere, 4 AutoMark, ..
. . _ utotrar. |
M‘Z‘E’m H ionosphere, 3 - — |
Updat_e a Table Of Contents ™ Headings For accented letters Columns: |2 ﬂ
1. Click anywhere in the table of contents I Right alin page nurbers bkt oo 2
2. Press F9
Table
Terms:

A. Table — A grid comprised of row and columns into which you can enter data.
Column — A vertical series of cells in a table.

Row — A horizontal series of cells in a table.

O 0w

Cell — The rectangular area at the intersection of a column and a row in a table, into which
you enter data.

E. Gridlines — Nonprinting lines that can be displayed around cells in a table.

F. Merge — Combine

G. Split - Separate

Table Screen.:

Row /

. Cell | / u
/  \m

Gridlines / Borders
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Inert a Table: o
A. Click the Insert Table icon on the toolbar []

B. Drag the mouse across the grid to select the number of columns / rows in the table

or .
C. Click Table on the menu bar H ..

D. Click Insert i ..

E. Click Table

| 2 x 2 Table

ed 4
Table size
F. Insert Table dialogue box appears — Nurnber of colurnns: E =
¢ select number of columns / rows Mumber of rows: I2 5
o select AutoFit Behavior - il 7l [ ersloy
) ) * Fixed column widkh: I.ﬁ.utu 5‘
Fixed column width = the width will not change; Y e
AutoFit to contents = width of the cells will fit to AUboFit bo window

content being typed; Table Format - (none)

AutoFit to window = table will fit to window on monitor

e Table Format — AutoFormat the table accordin Set as default for new tables

to preset formats such as table layout, fonts, font color, 2t emeel
G. Click OK
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Insert / Delete Columns or Rows:
A. Insert Column / Row -

e Click inside the cell next to where you want to insert a new column or row

e Click Table on the menu bar

e Click Insert p—
e Select one of the following - columns to the left, Table | indaw Help
columns to the right, rows above, rows below, cells | j Dra Table
Inserkt
B. Delete Column / Row - Delete
—

e Click / select the column / row you want to delete
e Click Table on the menu bar

e Click Delete

e Select on of the following — columns, rows, cells

C. Delete Entire Table -

Tahle Jﬂindnw Help
[ Insert » E 1 E =2
|

"U" Columns
P . g}'ﬂaws

. Click anywhere inside the table
. Click Table on the menu bar

. Click Delete —

. Click Table

Change Column Width and Row Height:
A. Position the mouse over the border line - * the mouse will change into a double-headed

arrow

B. Click and drag the border to move it left, right, up, and down

Move and Resize Tables:
A. Move Table —

e Click the table so the handles are displayed

e Click and drag the move handle to the new location

e Release the mouse button to drop the table into the new location
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B. Resize Table -
e Click the table so the handles are displayed

e Click and drag the sizing handle to increase/decrease the table size

¢ Release the mouse button to resize table

Enter Data:
A. Type data into the cells of the table

B. Move between cells by clicking in each cell, or push the Tab key on the keyboard

C. Row height increases automatically to accommodate the data

D. When you press Enter in a cell, the cursor will double-space and Return to the left of the
cell

E. Format Text — Edit text in a cell / table the same way you do in a document

Tahble] "Window Help

serk

I
Table Properties: ' Delete
A. Click anywhere inside the table

B. Click Table on the menu bar
C. Click Table Properties >

| ﬁ Table AutoFormat. .,

I%l ok, .,

| Table Properties. ..

D. Table Properties dialogue box appears -
o Table tab — change Alignment of table, select Text Wrapping, format Borders/Shading,
. Table Properties
and other Options ™\

[ Iabe | Row | cobm | cal |
e Row tab — change height and select row to change e

[™ Preferred width: ID" 5‘ Measure: in: IInches vl

e Column tab — change width and select column to change

> Alignment
e Cell tab — change Text Alignment within cells Indent from ft
O Bl B o=
Left Center Right
E. Borders / Shading — / S—
e Click on Borders / Shading button on the Table tab m mE

e Borders / Shading dialogue box opens — — postoning.

A
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1. Borders tab — change the borders style and color of the table or cell
2. Page Borders tab — changes apply to a border around the entire page
3. Shading tab — change background color and pattern of the table or cell

Borders | Page Border]  Shading I

skbing Preview Fill Preview
[ SR - Click on diagram below or use e Fil
None buttons to apply borders | | | | |
i ERNEN
____________________ LT T T
E RN [
------------- NEENENEE
s - NN
al m [
Color T | [ Mare Colors... |
E ’ I Autamatic j
Garid Patk
i Sl
| Yapt 7j Apply ko ||:| Clear j Fpply to:
E—ﬂ Cuskom Table
et Table Calor: F h
Eaeqlagraph I EtanEtE j aTagrap
Table Properties KE
LItk | row | coum | cal |
F. Table Opti o — ==
: able p 10ns — I™ Preferred width: [0 = Measurg in: |Inches
e Click the Table Options button on the Table tab Aigent
Indent Fromm left:
o Table Options dialogue box opens — El; i ;E !
1. Change Default Cell Margins Left Gl Right
2. Change Default Cell Spacing — allows spacing UL
between cells Table Options (7]
Default cell margins L
Pasitioning. ..
Top: [d P (T T |
Bottom: [0 = mght Joos X
Default cell spacing Iadi AN
[~ allow spacing between cells IU" 5‘
Options
¥ automatically resize ko fit contents
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G. Cell Options -
o Click the Options button on the Cell tab
e Cell Options Dialogue box opens —

1. Change Cell Margin options

2. Change the Text options — Wrap Text or Fit Text = <&lmargins
v iaame as the whole fable |

* if you Fit Text, the text will get smaller in order to
(*ify g o S i o
fit into the cell...may not be able to read) ottom: m Right: W
Opkions
¥ wWrap bext [~ Fit ket
Borders Toolbar:
o0
) g E 2 172} = : E
— — = < ) 3
> s .3 = =7 =2 €8 *=c =
S @ © =N - ) 0 o 7z g’n,g )
o) o = 5 2 E £ o 2 2 =5 2
72} o e N - <
< = Qo0 .= = = ) o = Sz < D o 2
= 3 £ 3 S s & 2 § =& 25 =k 7
= .J\'& 2 7 ﬁ — i 7 (=Y = /
7 2 - wed -0 00 Er A AR 2LE =
A o
- 8 A=
&l s £ =
< 55 32
P o D <
L2352 @
Ao o
Merge/Split Cells:

A. Select the cell(s) to merge or split
B. Click the Tables / Borders icon on the toolbar
C. Click the Merge icon or the Split Cells icon on the Tables / Borders toolbar 1 B

or Table }zindnw Help

D. Click Table on the menu bar : i
E. Select Merge Cells or Split Cells | B :
Delete ’
Seleck d
ﬂ Merge Cells
[ solit Cells. .
Split Table
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Orientation of Text:
A. Click in the cell where you want to format text direction

B. Open the Tables / Borders toolbar =
C. Click the Change Text Direction icon — change text from vertical to horizontal M|

Table § Mfinc
i Inserkt
Sort: I Delete
A. Select the column you want to sort .
£ Table &
8. ClilcTable on the meny bar_——1py
£ v |
C. Click Sort
D. Sort dialogue box opens —
+ Choose the Header Row fitie you won: (TS 2lx
to sort by first — click the down arrow | Sork by o ;
ﬁ , *  Ascending
. | Type: -
under Sort by: to see list foaiusc. B 4R ITEXt :I  Dpescending|
e Choose Ascending / Descending order | Then by & Aot
Type: |[Text hd * Ascending
e If you want to sort a second columV'LI | ex :I e Desceuding|
would make the applicable choice§ Then by & i
under Then by: I = e ITEXt :Iv " Descending
o Seclect Header Row or No Header Row M list has
" Header row % Mo header row
e Click OK
(a4 I Cancel Cipkions. ..
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Mail Merge

Creating a New Main & Data Document:

Create the Main Document:

e Open Microsoft Word
o Enter the text of the document. Type in --- in places where you want to include
the merged field data.
e Save the main document - click File from the menu bar, then click Save As).
e Click Tools on the menu bar
,E Table Window Help

e Click Mail Merge from the drop down men 5 oo and
e Start with number 1: Main Doc. \ —
e Click Create, and select Form Letters

Mail Merge...

: . . (=] Enwelopes and Labels...
e Click Active Windo \ S

»
]

B ]
=1 main documernit

Active Window Pew [Main Document |

Create ™ Setup...

Form Letters...

2 Mailing Labels. ..
2
Envelopes...

Create Data Source Document:

** The data source document is a table that contains the information to be merged and the
first row (header row) contains field data names. 2 o
=l patasource ——————
e Click the Get Data button to select a data source )
o Select Create Data Source

GetData = |

Create Data Source. ..

Cipen Data Source. ..
3
Use Address Book. ..

Header Options. ..

Create Data Source EHE

A mail merge data source is composed of rows of data. The first row is called the
header row. Each of the columns in the header row begins with a field name.

Word provides commanly used field names in the lisk below. You can add or remove

Data SOllrce DialOElle bOX: figld names ko cuskomize the header row,

Field name: Field names in header raw:
. WorkPhone
e Scroll through the list of field names ! _
Add Field Mame #r |
e Remove a field — remove all fields you

do not want in the Main Doc. Femove FieldName |

1. Click on the field name /&I o | cancel |
2. Click Remove Field Name button

Prepared by MLY 12
Technology Dept.
2002-2003



e Add a field — create your own fields to insert into the
Main Doc.; field names must be unique and can be up to
40 characters (*it must start with a letter and cannot contain spaces)

1. Click inside the Field Name box and type your own field name
2. Click Add Field Name>> button — under Field Name in Header Row
you should see youynewly created Field Name

Field names in header row:

Field name: /

add Field Mame »»

Remove Field Mame

e Rearrange Field Names

1. Click on the field name to be

moved

Title
Fit sEM arne

Create Data Souice

A mail merge data source is composed of rows of data. The First row is called the
header row, Each of the columns in the header row begins with a field name.

‘Ward provides commonly used field names in the list below, ¥ou can add or remove
field names to customize the header row,

Eield name: Field pames in header row:
|WorkPhone FirstMame ;I
Lasthame *®
add Field Name #» | _I
JobTitle Mave

2. Click the Move (up or down) /M o .

button

MS Query... | oK I Cancel

e Click OK to save the Data Source document (which contains no data yet)
e The Save As dialogue box will appear — in the File Name, type the name of the
Data Source file (EX: Secretaries, Principals, Curriculum Dept., Second Grade)

e Click the Edit Data Source button to add records

Microsoft Word

records to ydur data source by choosing the Edit Data Source button or lay out vour

® The data solfrce vou just created contains no data records. You can either add new

main documeld by choosing the Set Up Main Document button,

Edit Diata Source

| Set Up Main Cocument I
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o Enter the data in each field
Data Form 7| x|

Title: | ﬂ oK |

FirskMarne: Add Mew
L asthlame: 7
/ Delete |

JohTitle: =

Campany: Restare |

Address1: Find... |
Addressz:

Citys ‘iew Source |
State: ﬂ

Record: | 4 I1 3 | Pll

e To add another record — click the Add New button, continue until all records have

been added
e When finished — click OK to save the data and close the file

Merge the Documents (New Main & Data Source):

Insert the merge fields:

e The Main Document should be the active document — Don’t know? Check the title
bar...it should be blue. The mail merge toolbar is now visible.

e Go to one of the --- in your document and delete it (remember, this is where you
will insert your merge fields)

e Click on Insert Merge Fields from the toolbar above

[l )
PInsert Merge Figld -

e Click on the field to insert, continue to insert merge fields throughout your I ;:::Name
document until you are finished I
e Save the document — click File on the menu bar, then click Save JohTitle
Zampary
Address1
Addressz
ity
Skake
PostalCode
Country
HomePhone
WorkPhone
Prepared by MLY 14
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Merge:

e Click the Merge button |Merge... | from the toolbar above
e Under Records to be Merged in the Merge dialogue box, select All or a

specific range of records to merge (EX: 11-23
e Click Merge on the upper right hand side
of the Merge dialogue box 2 —

. Metge ko > Merge
o Notice that all of the merged documents W sowp. | =T
Cancel |
have been sent to your desktop, make Records to be merged
. & al »E I Tiar I Check Errors... |
sure the document is correct before s H 5 :
. . Query Opkions. .. |
prlntlng —when merging records
. . . ' Don't print blank ines when data fields are empky.
b Prlnt documents - Cth Flle on  print blank lines when data fields are empty,
the menu bar’ Cth on Prlnt Mo query options have been set,

Use an Existing Data Source:

Locate the Data Source:

e Locate, select and open the Data Source Document you want to use — Word doc.
(table); Database (Access); Worksheet (Excel)

e Create a Header Row with Field Names if there isn’t one — the Header Row is what
names the fields to be merged; it needs to be above the merge data

e Click File on the menu bar — Click Save

e Close the Data Source document

Create the Main Document:

Tools Table Window Help

Click Tools on the menu bar = :
J’ Speling and Grammar...  F7

Click Mail Merge from the drop down memi____ |
Start with number 1: Main Doc.
Click Create, and sclect Form Letters

165 -
=1 main document —
[ Create = 1 Setup...

Mail Merqge. ..

= Envelopes andllatels, ..

¥

Form Letkers. ..

Mailing Labels. ..

R
2 Envelopes. ..

« Click on [ getve windaw | (This is your main document.)

e Open the Data Source document: 5
akta soUrce

1. Click the Get Data button | Get Data - |
2. Select Open Data Source from the drop dow Create Data Source. ..
menu Open Daka Source. .,
IJse address Book, ..
Header Options. ..
Prepared by MLY 15
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3. Locate, select, and open the document

— you may need to change the Files of Type to All Files
4. Select the following —

Database file — select table or query to use
Workshegt — select entire spreadsheet or

all word Documents -

415 Access Databases N -
M5 Excel Warksheets B
M3 Cuery Files
dBase Filas

tamed ar cell range:

e Spreadsheet

Entire Spreadshest

(] 4 I Cancel |

5. Click OK
6. Click the Edit Main Document button

. Type the Form Letter:

. ield ~ .
1. Click on the Insert Merge Fields button I nesrt Meree e , from the mail

merge toolbar above, to mark the place where text from the data source
will be inserted

2. Save the document — click File on the menu bar, click Save As

Merge the Documents:

e Click Tools from the menu above, or click the Mail Merge Helper icon on the
toolbar

e Click Mail Merge
e Click the Merge... button |Merge... | to display the Merge dialogue box
e Set the Merge options -

*Leave Merge to: defaulted to New document

*Records to be merged: All (display all merged records) or From: (displays a
range of documents to merge)
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e Click the Merge button on the upper right hand side of the dialogue box

Merge 2

Cancel |
~Records ko be merged
&al C Fom | Io: | Check Errars... |

Quety Opkions. .. |

—fhen merging record:
% Don't prink blank lines when data fields are empky.
" Print blank lines when data fields are empty.

Mo query options have been set.

e Print documents — click File on the menu bar, click on Print

Create Mailing Labels by Merging an Address Book:

Set up the Address Book:

e Open the Address Book

e Click on File

e Click on Export

o Select Entire Address Book

e Save Data Source — click File on the menu bar, click Save As (save to Desktop)
e Close Address Book and mailbox

e Double-click the desktop icon

e Select the Target Address Book — (the one with your name)

e C(lick OK
Tools Table ‘Window Help
'5' Speling and Grammar... F7
. ail Merge =
Create the Main Document: Mail Metge. . 1 Main document
V=" Envelapes and Labels..
. ¥ Creake ™
e Click Tools on the menu bar E =
o Click Mail Merge from the drop down menu T LBEETE
o Start with number 1: Main Doc. Maiing Labels...
e Click Create, and select Mailing Labels Va4 Enwelopes. ..

e Click Active Window

[
2 Data source ————————
] Get Daka ™

Trazka

Open or Create the Data Source:

Mizk= SALema

e Click the Get Data button

Open Data Source, ..
e Select Open Data Source

Header Cptions. ..

Prepared by MLY 17
Technology Dept.
2002-2003



e Locate, select, and open the document

— you may need to change the Files of Type to All Files
e Click OK
e Click Set Up Main Document

Files of Evpe: | all word Documents -

M5 Access Databases af
M3 Excel Worksheets
M3 Query Files
dBase Files

M5 FoxPro Filas

Select Label Type:

e Select the type of printer and labels you want to use
e Click OK
¢ You will be asked to set up the labels, including inserting the merge fields

Insert Merge Fields:

e In the Create Labels dialogue box, insert Merge Fields where you want to merge
information

Create Labels

e Toinserta merge field: Choose the Insert Merge Field butkon
sample label, You can edit and Format
Sample Label box,

1. Click Insert Merge Field
2. Click the Field Name you want to inse

3. Click OK Insert Merge Field -
Sample label:
aFirst MNames «Last MNames
# Titles
Merge the Data: «D) EPEITIHEﬂt”|

e Click Tools from the menu above, or click the Mail Merge Helper icon on the
toolbar
e Click Mail Merge
e Click the Merge... button |Merge... | to display the Merge dialogue box
e Set the Merge options -
*Leave Merge to: defaulted to New document
*Records to be merged: All (display all merged records) or From: (displays a
range of documents to merge...good for testing before merging all)
*Click the Query button (on the right) — sort and select data records to merge
e Click the Merge button on the upper right hand side of the dialogue box
e Print labels — click on File from the menu bar above, click on Print
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